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What is the SDA - ATAAPS Payroll Pass to DCPS
Application?

The SDA - ATAAPS Payroll Pass to DCPS application retrieves data from the ATAAPS data base,
based on defined criteria, and puts it into ASCII file format for eventual transmission to DCPS.

A typical file format consists of record type 1 (header record); record type 2 (tour of duty change
record); record type 5 (reported labor record); and record type 6 (trailer or total record).  The
inclusion of record type 3 (accounting record) and record type 4 (certification record) data is
optional.

The SDA - ATAAPS Payroll Pass to DCPS application also provides the option of merging
multiple SDA files into one ASCII file.
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Creating the Upload File

To create the SDA upload file (from ATAAPS to DCPS):

1.  Click on Options, which is located on the main menu.

2.  Click on Default Directory.  The Default Directory window will open.  Insert the directory path
     where the SDA file is to be saved.  Click OK.

Default Directory Window

This window is used to establish a full directory path where the SDA file will be stored.  All
future SDA files which are created will also be stored in this directory.  If the exact
directory path is unknown, click the Browse button and make a selection.  Click OK to
complete the process and return to the main window of the application.

NOTE:  To generate tour of duty change records (Record Type 2) for ALL employees,
click, to place a check mark beside, the statement that reads: Generate tours for all
employees on SDA.  If there is NO check mark, then tour records (Record Type 2) will
be generated for ONLY those employees whose tour of duty changed since the last SDA
creation.  This statement is located under the Options menu item.
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3. Click the Upload button.

4. Respond to the steps in the:

SDA - ATAAPS Payroll Pass to DCPS Wizard

Step 1

Step 1 of the SDA - ATAAPS Payroll Pass to DCPS Wizard is merely a welcome window.
Once it has been read, simply click Next to continue.
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Step 2

Select a pay period ending date for the report.  Insert the correct date and click Next to
continue.  (NOTE:  Only one SDA can be created for a particular pay period ending date.)
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Step 3

Select the type of records that will be included in the file that will be created.  Make the
appropriate selection and click Next to continue.

Record Type 1 (header) and Record Type 6 (trailer) will automatically be created.  A
check mark in the Create Labor field will generate Record Type 5; Create Tour will
generate Record Type 2; Create Accounting will generate Record Type 3; and Create
Certification will generate Record Type 4 records.  NOTE:  Type 4 (certification)
records will NOT be created if an employee is not certified or if the SDA date is less
than the certification date for that pay period.
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Step 4

This window simply recaps some of the criteria that was selected in the previous steps.  If
the information is correct, simply click Finish to retrieve the records.

5. After the wizard has retrieved the data, a “Create File” window will appear.

Create File Window

This window contains a series of tabs that, when clicked, display the records by Record
Type, which will be included in the SDA file. (NOTE:  A similar window, called “History
File”, appears when reviewing historical data .)

The five tabs on the window are:
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• Tour of Duty - displays tour of duty change records (Record Type 2) that will be
passed to DCPS.

• Accounting Default - displays accounting records (Record Type 3) that will be
passed to DCPS.

• Certification - displays certification records (Record Type 4) that will be passed to
DCPS.
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• Reported Labor - displays reported labor records (Record Type 5) that will be
passed to DCPS.

 

• Control Totals  - displays control totals (Record Type 6) that will be passed to DCPS.

6. Click the Create File button, which opens the SDA Comments Window .

SDA Comments Window

Enter any comments you may have.  Click OK to actually complete the process and
generate the SDA upload file extract.
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To review historical data (i.e., SDA file extracts that had previously been created):

1.  Click the History button, which opens the History File window.

History File Window

This window will appear when the History  button on the Main Toolbar is clicked.  It is
used to input the full directory path and name of the historical file that is to be reviewed.  If
the exact path and file name are unknown, click the Browse button and make a selection.
Click OK to complete the process of selecting the file.

2.  Insert the directory path and name of the file to be viewed.  Click OK.

3.  The “History File” window, which is similar to the “Create File” window in Chapter 2, will appear.
Click on each of the tabs on that window to review the records that were processed for that
particular record type.

4.  Click the Properties button, which opens the SDA Properties Window.  View or modify any
comments you made when the file was initially created.  Click OK.

SDA Properties Window
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5. When the review has been completed, close the window or exit the application.



Chapter 4  - Merging SDAs                                                                                       31 January 1999

11

&+$37(5�����0(5*,1*�6'$V

To merge multiple SDAs:

1. Click on Options, which is located on the main menu.

2. Click on Merge Parameters.  The SDA Merge Parameters window will open.

SDA Merge Parameters Window

This window is used to identify the SDA input files that are to be consolidated
and to name the newly merged file.

Click the Add button.  Insert the SDA Identifier code for the appropriate data base.
(These codes are assigned on the Settings Tab of the Administration Codes Window
of the Main ATAAPS Application.)  Repeat this process until the SDA Identifier Codes
for all applicable data bases are listed.  If an SDA identifier code is listed that is no longer
valid, click on it and then click the Delete button.

Enter a name for the consolidated file (in the field called “SDA Identifier for new file
created from merge:”).  This file name should be the SDA Identifier Code that DCPS is
expecting to see on the input file.

Click OK.

NOTE:  Once you have initially established the Merge Parameters for your consolidated
file, you can skip to step 3 for all future consolidation exercises.  You would only need to
access the Merge Parameters window if there would be a need to add or delete the SDA
Identifier Codes that were identified.
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3. Click the Merge SDAs  button, which opens the Merge SDA Files Window .

Merge SDA Files Window

This window is used to identify the specific files (containing the SDA Identifier Codes) that
will be included in the consolidated SDA file that will be passed to DCPS.

Click on Browse to select the specific file(s) created during the upload process , which
contain the appropriate SDA Identifier Code(s).  Click OK.

4. A window similar to the “Create File” Window will appear (see chapter 2).  Review the data on
each of the tabs.

5. Click the Create File button, which will complete the process and generate the consolidated
SDA upload file extract.
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This window is displayed when the SDA - ATAAPS Payroll Pass to DCPS Application is
first opened.

MENU ITEMS

• File - Provides for access to the upload, history, and merge SDA processes;
customizing the toolbars; and exiting the application.

• Options - Allows for establishing a default directory for storing SDA files; identifying
multiple SDA files to be merged into one; and generating tour of duty changes
records for ALL employees.

• Help - Accesses the application’s Help File and provides information about the
version of the application.

TOOLBAR ITEMS

• Upload - Creates an SDA file.

• History - Allows for the review of previously created SDA files.

• Merge SDAs - Merges multiple SDA files.

• Help - Accesses the application’s Help File.

• Exit - Closes the application.
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Main Toolbar

The main toolbar is used to navigate through the various windows in the application.  This
toolbar will be displayed continually while the application is open.

Secondary Toolbar

This toolbar is displayed when the user clicks the Upload, History, or Merge SDAs buttons
on the main toolbar .

When clicked:

• The Create File button, will generate the SDA file extract using the records displayed
in the Create File Window .

• The Properties button allows the user to insert or modify comments relative to SDA
input files that are created.   It becomes active when the History button on the Main
Toolbar has been clicked.

• The Print  button will print the information displayed on the open window.

• The Close button will close the window that is currently open.



Chapter 7  - Menus                                                                                                    31 January 1999

15

&+$37(5�����0(186

Main Menu

This Main Menu is available when the application is first opened and the main
toolbar is active.

• File - Provides an alternative method for accessing the items on the main
toolbar and for exiting the application.

• Options - Allows for establishing a default directory for storing SDA files;
identifying multiple SDA files to be merged into one; and generating tour of
duty change records for ALL employees.

• Help - Provides access to the application’s Help File and information about
the version of the application.

File Menu

The File Menu provides an alternative method for accessing the processes
available on the main toolbar; customizing the toolbar;  and exiting the application.

• Upload SDA File - Creates the SDA file.

• History - Provides access to previously created SDA files.

• Merge SDAs - Consolidates multiple SDAs.

• Toolbars - Customizes the location and size of toolbars.

• Exit - Closes the application.
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Options Menu

The Options Menu is used to define a default directory for storing SDA files;
identifying SDA files to be merged; and generating tour of duty change records for
all employees.

• Default Directory - Identifies a default directory for storing the SDA files that
are created.

• Merge Parameters - Identifies the SDA files that are to be merged into a
consolidated file.

• Generate tours for all employees on SDA - If this option is checked, then
tour of duty change records (Record Type 2) will be generated for ALL
employees.  If this option is NOT checked, then “Type 2” records will be
generated for ONLY those employees whose tour had changed during the
reporting period.

Help Menu

The Help Menu is used to access the application’s Help File and to view
information about the version of the application.

• Help Contents  - Opens the application’s Help file.
 
• Functional Letter - Describes the fixes and enhancements included in the latest

version of the application.
 
• Name of Current Window - Displays the PowerBuilder development

environment window name (which should be provided to the Technical Support
Staff is a problem is encountered on with a particular window).

 
• About SDA - ATAAPS Payroll Pass to DCPS - Provides information relative to

the version of the application.
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Secondary Menu

This menu appears when the upload, history, or merge SDA processes are run.

File Menu - Upload, History, and Merge SDA
Processes

This menu item is accessed from the secondary menu (that appears when the
upload, history, or merge SDA processes are run).

Data Menu

This menu item is accessed from the secondary menu (that appears when the
upload, history, or merge SDA processes are run).  Depending upon the process
that is being run at the time, it provides an alternative method for the creation of
the output file or inclusion of comments in the SDA properties window.
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Window Menu

This menu item is accessed via the secondary menu (that appears when the
upload, history, or merge SDA processes are run) and provides for arranging the
open windows and customizing the toolbar.
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You can contact the Systems Engineering Organization, Pensacola (SEOPE) Technical
Support staff by e-mail, fax, or telephone.  Our normal business hours are Monday through
Friday, from 6:30 a.m. to 4:30 p.m. CST.  Outside of these hours, emergency calls will be
handled immediately; other calls will be handled the next business day.

• E-Mail:

• ataaps.info@dfas.mil

• Fax:

• DSN:  922-1147

• Commercial:  850-452-1147

• Telephone:

• DSN:  922-2990, extension 310

• Commercial:  850-452-2990, extension 310
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